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DAY 1 - INTRODUCTION TO SAMPLE FILE USAGE AND  
SAMPLE PREP 

 

LAB Session 1 -  Intro to sample prep and sample files  

 Physi Sample Prep  

Sample preparation is the foundation upon which any good, reliable, reproducible 

analysis is built.  With the ASAP 2020 very few things can go wrong in sample 

preparation.  In this section we will examine these critical aspects. 

  Sample Quantity 

The ASAP 2020 measures pressure and then computes volume adsorbed as a result of 

changes in pressure.  Very slight errors in measurement may be caused by minute, 

inherent transducer error. 

There is a sacrifice of accuracy when the total amount of sample in the test tube is very 

low.  For the highest accuracy possible, greater amounts of sample should be used.  

Total surface area amounts approaching 50 m2 are not uncommon for highly accurate 

analyses.  Remember, however, that the greater the amount of total surface area 

present for analysis the more time must be allowed for the analysis.  You should 

develop your own standards as you discover the best methods for your needs. 

Of course, any weighing errors, no matter how small, are magnified when low sample 

masses are used.  This is why a minimum of 0.1 g is specified.  When analyzing a light 

or fluffy material, the entire area of the test tube within the heating mantle can be filled 

with sample in an attempt to attain sufficient sample mass. 

Remember that the sample mass initially placed in the sample tube will be reduced as a 

result of the removal of trapped moisture (degassing).  It is usually a good idea to use 5 

- 20% excess sample mass than required so a sufficient mass will remain after the 

sample has been cleaned. 

The seal frit is a convenient method to insure sample material is not contaminated as it 

is transferred from the degas port to the analysis port.  It is simpler to use than a rubber 

stopper and we recommend its use as part of standard sample preparation. 
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LAB – Initial Sample Preparation 

 
Please use the following items , an analytical balance, and the sample data sheet 
(below)to perform the steps below. 
 
 

Clean Sample Tube 

 
Filler Rod 

 
 
 

Seal Frit 

 
Weighing Support 
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Reference Material (Carbon) 

 
 
 

 

1. Tare the balance with weighing support in place. 

2. Weigh the assembled sample tube (including filler rod and seal frit ) using the 

weighing support for stability. 

3. Record this mass on the sample data sheet. 

4. Tare balance with weighing dish. 

5. Weigh approximately 0.60 grams of Carbon reference material. 

6. Load the sample into the sample tube. 

7. Insert the seal frit into the top of the sample tube. 

8. Prepare a second sample tube, this time using about 0.25 grams of the Silica-

Alumina reference material. 
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ASAP Series Sample Data Record 
Sample tube:_____________________ Sample: __             Carbon_____________ 
 
 
Before Degas: 
 

 

1. Mass of empty sample tube assembly (sample tube,     seal frit and filler 
rod) 
 

________ g 
 

2. Mass of sample tube assembly plus sample ________ g 
 

3. Mass of sample (Step 2) – (Step 1) ________ g 
 

After Degas: 
 

 

4. Mass of sample tube assembly plus sample ________ g 
 

5. Mass of sample (Step 4) – (Step 1) ________ g 
 

After Analysis: 
 

 

6. Mass of sample tube assembly plus sample ________ g 
 

7. Mass of sample (Step 6) – (Step 1) ________ g 
 

 
 

You may use the After Degas value (Step 5) or the After Analysis value (Step 7), 

provided they are close to the same value. 

Compare the sample mass obtained after analysis (Step 7) with the sample mass after 

degas (Step 5). 

These two values should be close in range. If a significant difference is noted, analysis 

problems may exist or the sample may have been improperly degassed. 
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ASAP Series Sample Data Record 
 
Sample tube:_____________________ Sample: _         Silica Alumina_______ 
 
Before Degas: 
 

 

1. Mass of empty sample tube assembly (sample tube,     seal frit and filler 
rod) 
 

________ g 
 

2. Mass of sample tube assembly plus sample ________ g 
 

3. Mass of sample (Step 2) – (Step 1) ________ g 
 

After Degas: 
 

 

4. Mass of sample tube assembly plus sample ________ g 
 

5. Mass of sample (Step 4) – (Step 1) ________ g 
 

After Analysis: 
 

 

6. Mass of sample tube assembly plus sample ________ g 
 

7. Mass of sample (Step 6) – (Step 1) ________ g 
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TRAINING ACTIVITY – UNITS 

 

Some of the values displayed by the 2020 can be presented in a variety of units.  The 

selection of units is found in the Options menu.  Before you begin your other laboratory 

activities, you need to change a few of the default unit assignments.  Please select 

Units on the Options menu  and make the Unit Selections outlined below.  

 

 
 

CLEANING THE SAMPLE 
 

Before a sample can be analyzed, the sample surface must be cleaned.  Any volatile 

materials adsorbed on the surface must be driven off.  This process is known as 

degassing.  If degassing is not performed or is incomplete, the total sample surface will 

not be available for adsorption and the collected data will not represent a true measure 

of the surface area and porosity of the sample. 
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With this instrument, the sample is exposed to heat while being placed under vacuum.  

The heat serves to drive off these contaminants while the vacuum system exhausts 

them away. 

The instrument requires that the operator select a temperature for each degas port.  

This should be the maximum heat possible which will not cause a change in the surface 

and porosity characteristics of the sample.  Using the highest possible temperature will 

shorten the degas time required to prepare a sample.  If a safe temperature is not 

known and/or a low temperature must be used, the degas time will be lengthened.  The 

instrument is designed so that the level of sample outgassing can be checked at any 

time during preparation. 

When the system exposes the sample to a vacuum, it introduces the sample to this 

vacuum gradually.  This is accomplished through the use of a restricted valve.  The 

operator is required to determine a pressure crossover point at which the unrestricted 

vacuum valve opens.  This exposes the system directly to the vacuum.  Using a 

restricted valve initially  prevents sample fluidization.  If the sample is either a very fine 

powder or a very fluffy material, this crossover point must be carefully set, usually at a 

low level (typically less than 100 µmHg).  In the case of Silica Alumina. This is not a 

problem. It is too heavy to fluidize and too large to get past the seal frit. 
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TRAINING ACTIVITY – CARBON SAMPLE FILE CREATION FROM PRE-
EXISTING PARAMETERS 

 

We will load each sample onto the degas system of the instrument shortly, but first we 

must create sample files for each.  

Sample degassing is controlled through the ASAP operating software.  The degas 

conditions are kept in the sample information file which is also used to control analysis 

of the sample, reporting of the results and storage of the analysis data.  We will create 

the sample file for the Carbon Reference Material first.   

  

 

 

Restricted valves 
2 and 4 

Unrestricted 
valves 1 and 5 

This smaller 
line 
designates 
a restricted 
valve 
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LAB (Creating Carbon Sample file) 

 
Click on File, Open, 
Sample information. 

 
Degas parameter 
files with the 
conditions we need to 
degas and analyze 
the carbon sample 
are contained within 
2020 software.  You 
will use these 
parameter files to 
create a sample file.    
You would click  

 to accept 
the default  file name 
in this case it is 
000.012.SMP (Your 
default name may 
differ.). For this test 
please type in 
“CARBON”.  It will 
make it easier to 
locate the file later.   

 

OK
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Then Click on 

 to create the 
new sample file.   

Type Carbon 
Reference Material 
for your sample 
identification.  It is 
also a good practice 
to add your sample 
tube and/or stopper 
identification to this 
field.  You may enter 
your initials as the 
Operator.  Please 
leave “Submitter” 
blank.  You would 
use this to track who 
asked for a data file 
to be run. 
 
 

 
NOTE: If your file 
does not contain the 
tabs shown above, 
please click the 
“Advanced” tab to 
change from the 
“Basic” file mode.   
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Next, select the 
Degas Conditions 
tab.   

 

Click  and 
select the D-4 
Carbon degas 
conditions file.  We 
are not using D-4 
carbon, but the degas 
conditions used will 
be the same. 
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To finish the file, use 
the same procedure 
as above to select 
surf5.anc for the 
Analysis Conditions 
…. 

 
and surf.rpo for the 
Report Options.  
Finally, click  

, then 

, and 

. 
 

 
 
   
 
 
 
   

 
  

OK

Save

Close
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 Training Activity – Automatic Si/Al  Sample File Creation 

    

The ASAP 2020 program is designed to allow you to easily create and analyze sample 

files.  One way the software does this is to use Automatic Sample File creation.  An 

operator may define several conditions like, for example, the Analysis Conditions or 

Report Options that were selected during the last exercise.  These conditions can then 

be used to automatically generate a sample file.  This procedure will be covered in 

detail now. 

 
 

LAB – Si/Al Sample File Creation 

 

You will now create another file using both default and previously programmed 

conditions.  The ASAP 2020 allows six types of files to be created. 

 
1  Sample Information  a complete sample file 
2  Sample Tube sample tube information 
3  Degas Conditions parameters which control sample degassing 
4  Analysis Conditions parameters which define the analysis process 
5  Adsorptive 
Properties 

the analysis gas properties 

6  Report Options data reduction methods 

The last five file types above are used to insert into a Sample Information file to assist 

with automating the file creation process.   

Please perform the following steps to initiate your sample file creation. 
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Click on File, Open, 
Sample Information 

Once you have 
accomplished this you 
will see the Open 
Sample Information File 
dialog box.  A File 
name is automatically 
displayed.  This is the 
file name under which 
this sample will be 
stored on the computer 
and is chosen from the 
default values.  You 
may overwrite the 
default file number 
provided with your own 
file name with up to 8 
characters.  
A box for Selection 
Criteria is displayed 
below.  Here we can 
select the files from 
which we wish to 
choose in the event 
that we are opening an 
existing file.   
 
 
 
Click on the down 
arrow at the right of the 
Status box.  We can 
choose to see files 
which: have not been 
analyzed; are currently 
analyzing; are 
complete; are manually 
entered; or all sample 
files. 
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A further selection 
method allows the 
choice of date ranges.  
Click the 

 
button.  This allows the 
user to select files by 
all dates or a date 
range.  
F2 clears the date 
F3 inserts current date  
F4 displays a calendar 
for a date selection. 
 selection by all dates 
or a date range.  

 
 
 

  After looking at these options, click the  button to return to the previous 

dialog box.  This will allow you to NOT save your changes in this case. Click the 

 push button to open this sample file and make the following changes. 

 
This time, type Si-Al 
Reference Material for 
your sample 
identification.  It is also 
a good practice to add 
your sample tube 
and/or stopper 
identification to this 
field.  You may enter 
your initials as the 
Operator.  You may 
leave “Submitter” blank 
if you choose.  Please 
leave the Mass as the 
default number. 
(1.0000) We will 
change this later.  Also 
note that when you 
click in the Mass field, 
you get a message at 
the bottom of the 
screen describing the  
range for that entry. 

 

Cancel

OK
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Select the Degas 
Conditions menu.  
Enter the following 
information into the 
specified fields. 
 

 
Click on the Analysis 
Conditions tab.  Select 
the Silica Alumina, 
isotherm, N2 @ 77 K 
analysis conditions set.  
This allows selection of 
preprogrammed 
analysis parameters.   



19 
 

Before you start the 
analysis, please make 
the following changes 
to the default values. 
 
Under Preparation, 
select Fast Evacuation 
since this sample will 
not fluidize. 

Under Dosing, select 
Maximum Volume 
Increment and make 
sure the  value is set to 
25.0 cm3/gm STP. 
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Finally, select the 0.995 
P/Po data point for 
Total Pore Vol.  Please 
note that you may have 
to click on the current 
value in order to 
deselect it first. All 
other Analysis 
Conditions can be left 
as their default values. 
 

The next tab is for the Adsorptive Properties.  Adsorptive properties are used to define adsorptive 
gas characteristics for the analysis gas.  No change needs to be made here since we will use 
nitrogen as the analysis gas. 
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The last part of the 
sample file is used to 
select the Report 
Options.    Click on the 

 and select 
the Full Report Set. 
 

We are now finished with programming this sample file.  Review the conditions you 

have enetered, and be sure to ask your instructor if you have any questions.  If not, click 

the  and  buttons to save the file. 

 

TRAINING ACTIVITY – Start Degas 

 

If both Carbon and Silica-Alumina samples are loaded onto their respective degas ports 

and both sample files have been created, you may initiate the degas process for these 

samples.  Please perform the steps below to do so. 

Close Yes
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Select Start Degas… 
under the Unit 1 menu. 

 
For the appropriate 
ports, click 

 and 
select the file you 
created for each 
sample.  The 
instrument will use the 
degas conditions you 
programmed into these 
files.  If you wanted to 
change these 
conditions or if you had 
not already 
programmed a sample 
file, you could select 
conditions using the 
Degas Conditions pull-
down menu seen here.  
We will not be utilizing 
that feature in this 
case. 
 

 

Once you have selected the appropriate files, click  and begin the degas 

process for both samples. 
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Training Activity – Filling Analysis Dewar  

 

Please read the Precautions below and then follow the instructions for filling an analysis 

dewar.  Your instructor will show you how to operate the nitrogen Pump provided. 

 

Precautions 
Always handle Dewars with care. Any product with a glass vacuum flask is a potential 
safety hazard and should be treated with caution. Micromeritics recommends that 
the following safety practices when handling Dewars containing liquefied gases: 
 
Protect yourself by wearing goggles (or a face shield), an insulated or rubber apron, and 
insulated gloves. 
 
When pouring liquefied gases from one container to another:  

 cool the receiving container gradually to minimize thermal shock.  
 pour the liquefied gas slowly to prevent splashing. 
 vent the receiving container to the atmosphere. 

 
Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases 
(or other materials of extremely low temperature). Do not use a glass or metal stirring 
rod unless it is coated with some form of protective coating. 
 
Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover 
over the Dewar’s opening. If an object of sufficient weight is accidentally dropped into 
the Dewar, shattering may occur. 
 
Always install the Dewar cover before performing an analysis. The cover reduces the 
accumulation of ice. Accumulated ice could cause the Dewar to bond to the sample 
tube. 
 
Using the Analysis Dewar 

Fill the analysis Dewar with the analysis bath fluid to about 5 cm (2 inches) from the top. 

Incorrect fluid levels can lead to measurement errors.  Do not overfill the Dewar. 

 

Check the analysis bath fluid level with the dipstick as shown below. 
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Insert the analysis Dewar onto the elevator as shown in the following illustration. 

 
4. Place a Dewar insulator over the open Dewar until you are ready to start your 
analysis; this helps to minimize ice accumulation. 
 
5. When you are ready to start the analysis, remove the insulator and install a Dewar 
cover. 
 

NOTE:  A cold trap dewar is also part of the 2020 Physi instrument set up.  For our 

reference materials during this class, they are not necessary.  For unknown samples, 

and for general laboratory analyses, it is best to always use the cold traps which will 

prevent contaminants from the instrument’s degas or analysis from damaging the 

system. 

 

LAB Session 3 - Initiating carbon analysis 

Training Activity – Unloading degassed sample 

The next step in our analysis process is to unload the carbon sample we have 

degassed. 
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Transferring the Degassed Sample to the Analysis Port 

 

Please take a moment to study the following drawing and instructions before your 

instructor demonstrates how to move a sample from the degas port to your sample port. 

 

The sample tube assembly must be removed from the degas port, weighed and then 

installed onto the analysis port in order to perform an analysis.  The following steps 

should be followed to accomplish this. 

 

1. Allow the sample tube to cool.  Please use caution when removing sample tubes and 

clips, if they are not allowed to return to room temperature, they can be very hot! 

 

2. Carefully remove the heating mantle clip and the heating mantle from the sample 

tube and allow the sample tube to cool to room temperature (approximately fifteen 

minutes). 

 

a. Please use a gloved hand to support the sample tube by the stem when removing 

heating mantles.  The quartz tubes can/will break if not handled correctly. 
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3. While holding the sample tube, loosen the port connector nut and remove the sample 

tube from the degas port. If you are not using a seal frit, insert a stopper immediately.  

For this class all samples will use seal frits. 

 

4.  Remove the connector nut, ferrule, and O-ring from sample tube stem.  See above 

drawing. 

 

5. Weigh the sample tube assembly. Enter the weight on the Sample Data Worksheet 

as Mass of sample tube plus sample (After Degas). 

 

6. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample 

tube plus sample (After Degas) to determine the mass of the sample. Record this value 

as the Mass of sample (After Degas). 

 

7. Slide an isothermal jacket down over the sample tube stem until it touches the 

sample tube bulb. 

 

8. Place the connector nut, ferrule, and O-ring onto the sample tube stem. 

 

9. Remove the stopper and immediately attach the sample tube to the analysis port, 

pushing it fully up into the port. Secure it in place by screwing the connector nut onto the 

analysis port connector and hand-tighten the connector nut. 

 

10. Place the sample tube Dewar cover over the sample tube stem just above the 

isothermal jacket as shown in the following illustration. 
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.  

NOTE 

If a sample is unloaded hot (assuming precautions to avoid burning were taken) and 

weighed, the mass will be lower than it should be.  This is the result of the volume of air 

in the tube being less than when the tube was weighed at room temperature and the 

glass of the tube being dryer.  Both of these would combine to reduce weighing 

accuracy.  When helium is used as the degas backfill gas, care must be taken to either 

pre-fill the sample tube with helium before the initial weighing or use a buoyancy 

correction factor. Just think of a helium balloon. 

We have now completed all the preparatory steps necessary to enable us to begin the 

carbon sample.  One step remains, starting the analysis. 

 

LAB  Initiate Carbon Sample 

 

Now we will begin the analysis.  From the Main Menu Bar select Unit 1.  Select Sample 

Analysis … and then file CARBON.smp.  Select to generate a Report After Analysis.  

Make sure that Screen is selected for Destination: 

Press  to begin the analysis.  Tomorrow morning we will briefly go over the 

reports. 

 

Start
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LAB Session 5 - Preparing Y-Zeolite for analysis 
 

LAB  Weigh, create file and degas Y-Zeolite 

Please measure out approximately 0.15 grams of Y-Zeolite.   

Since we have one scale, please continue on to the next section and start the Y-Zeolite 

file creation if you are not using the scale. 

Remember that you may use the After Degas value (Step 5) or the After Analysis value 

(Step 7).  Please record both values and check to make sure that they are similar.  This 

serves as an accuracy check for sample weighing. 

Again, compare the sample mass obtained after analysis (Step 7) with the sample mass 

after degas (Step 5). 
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Sample tube:_____________________ Sample: _______Y-Zeolite_______________ 
 
Before Degas: 
 

 

Mass of empty sample tube assembly (sample tube, seal frit and filler rod) 
 

________ g 
 

2. Mass of sample tube assembly plus sample ________ g 
 

3. Mass of sample (Step 2) – (Step 1) ________ g 
 

After Degas: 
 

 

4. Mass of sample tube assembly plus sample ________ g 
 

5. Mass of sample (Step 4) – (Step 1) ________ g 
 

After Analysis: 
 

 

6. Mass of sample tube assembly plus sample ________ g 
 

7. Mass of sample (Step 6) – (Step 1) ________ g 
 

 

TRAINING ACTIVITY – Y-ZEOLITE DEGAS CONDITIONS 

 

We have created a complete sample file and performed an analysis with the information 

entered.  The ASAP has the capability of using many different analysis conditions.  A 

frequently analyzed sample could use the same parameters such as fast evacuation, 

leak test and rate, equilibration interval, and analysis pressure points, etc.  Once 

defined, they can be quickly recalled for use in an analysis. 
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One submenu of the File menu manages these for you.  We will now perform an 

exercise that will give you experience entering and manipulating these analysis 

conditions. 

It is helpful to build Degas Conditions, Analysis Conditions and Report Option Sets to 

apply to the majority of sample types analyzed in your lab.  That way creating a sample 

file would be as simple as entering the information on the first page of the sample file 

and choosing the ANC and RPO sets to insert.  This makes for simple file information 

management and frees you to perform other tasks. 

 

LAB  CREATING A DEGAS CONDITIONS FILE for Y-Zeolite 

 

In order to simplify the operation where multiple analyses of the same sample material 

regularly take place the stored Degas Conditions can be used.  We will now create a 

Degas Conditions file.  

You should be more familiar with the software structure now so this section will not use 

as many screen shots.  If you have difficulty finding a section, please ask your 

instructor. 

 

From the File menu, select Open then Degas conditions....  Name the file yzeolite.deg.  

Press  followed by  to create this file. 

Enter the following information into the specified fields.  Enter Y Zeolite for the 

Description of this file. 

For the Evacuation Phase     

Temperature ramp rate: 10.0 °C/min 

Target Temperature: 90 °C 

Evacuation Rate: 10.0 mmHg/s 

Unrestricted evacuation from: 10.0 mmHg 

Vacuum setpoint: 500 μmHg 

Evacuation time: 60 min  

For the Heating Phase 

Ramp rate: 10.0 °C/min 

OK Yes
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Hold temp: 350 °C 

Hold time: 480 min 

Press  then  to store the file when finished.  If you encounter any 

problems or have questions about this exercise, check with your instructor. 

Place your Y-Zeolite sample tube onto your degas port and begin degassing when you 

are done. 

LAB Session 6 - Initiating Silica Alumina analysis  

Training Activity – Silica Alumina Sample Initiation 

We have already created the sample file for the sample we will run overnight.  Before 

we leave today we have to cool down, unload, weigh the sample and start  the Silica 

Alumina file.  Please refer back to the ASAP Series Sample Data Record for Silica 

Alumina on page 6 and enter the remaining weights into that sheet. Remember to top 

off the Dewar and select screen as the report destination.   

    
 

DAY 2 - MICROPOROUS SAMPLES AND SAMPLE PREP 

LAB Session 1 - Building Y-Zeolite Sample file  

Training Activity – Analysis Conditions for Y-zeolite 

The Y-Zeolite sample prepped overnight so it should be ready for analysis.  This section 

will guide you through setting up the analysis file.  

 

LAB – Creating a Y-Zeolite Analysis File 

 

When multiple analyses of the same sample material regularly take place another useful 

parameter set is the Analysis Conditions file.  We will now create an Analysis Conditions 

file. 

From the File menu, select Open then Analysis conditions....  Name the file 

micropor.anc.  Press  followed by  to create this file. 

Close Yes

OK Yes
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Enter Y Zeolite Micropore Analysis for the Analysis conditions description:.  Selecting 

the appropriate fields, enter the remaining information from the following table.  For 

each section, click on the corresponding button in the analysis conditions dialog box.  

Clear the pressure table before entering the pressure range.  If a field is not included in 

the table, we will use the default value.   

 

Pressure table:  Use 32 points from P/Po = 0.01 to P/Po = 0.995 

Click on Insert Range and enter values 

 

 button: 

Fast evacuation Yes 

Evacuation time 0.0 hours 

Leak test No 

Use TranSeal No 

 button: 

Free space Entered 

Warm free space 28.0000* 

Cold free space 88.0000* 
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 button: 

Option 1 

Measurement Interval: 120 min 

 

 button: 

First Pressure Fixed Dose No 

Maximum volume increment No  

Absolute pressure tolerance 5 mmHg 

Relative pressure tolerance 5% 

Low pressure dosing Yes 

Dose amount 3.0 cm3/g 

 button: 

Equilibration interval 30 sec 

Minimum equilibration delay 600 sec 

 button: 

Backfill at start of analysis No 

Backfill at end of analysis Yes 

Backfill Gas N2 

* The actual free space values will be taken from your free space analysis.  

Press  then  to store the file when finished.  If you encounter any 

problems or have questions about this exercise, check with your instructor. 

 

 

 

 

 

  

Close Yes
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Training Activity – Report Options for Yzeolite 

Another of the information files that may be inserted into the Sample Information file is 

the Report Options file.  This file specifies the report name and the method of reducing 

and reporting data, including graphs, plots and reports. 

As with other file types, Report options are entered from the File, Open menu. At this 

time we will create a report option. 

 

LAB - Creating a Y-Zeolite Report Options File 

 

Using the computer and the previously loaded software, create report options as 

described.  Select File, Open, Report options... and enter yzeolite.rpo as the file name.  

Choose  to create the file.  At this point the dialog box displayed is similar to 

other file management screens for sample information and analysis conditions. 

Select Description: and enter Y Zeolite Micropore.  Select Show Report Title: and enter 

ASAP 2020 OPERATOR TRAINING.  The remainder of the screen shows the available 

report types.  Once selected, the reports can be edited to configure the form of the 

report. 

Select the Isotherm report, the BET Surface Area report, the Horvath-Kawazoe report, 

and the Summary report.  Select the report by Double-clicking the report in the Selected 

Reports list.  If a check appears beside the report, it is already selected.  Selected 

reports can be deselected by double clicking again.  Make sure that only the reports 

specified above are selected.  Finally, check the box to Apply thermal transpiration 

correction. 

Save the changes made and close the file.  We will use them later. 

 

Training Activity – Measuring Free Space of a Microporous Material 

 

Due to the entrapment of helium by microporous materials, special care must be taken 

to obtain free space values before a micropore analysis.  If free space is measured 

Yes
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directly before the analysis as usual, helium will be left behind in the micropores and 

lead to erroneous data during isotherm collection. 

 

To properly obtain free space values for our Y-Zeolite material, we wil: 

1. Measure free space independently BEFORE the micropore analysis.  

2. Re-degas the material on the sample port. * 

3. Proceed with the micropore analysis.   

*degassing materials on your instrument’s sample port is NOT recommended.  For a second degas of a reference 

material, there is no change of instrument contamination.  With all other samples, degassing should only be performed on 

the degas ports. 

 

Normally, an analyst would measure the free space of an empty sample tube prior to 

running an analysis on a microporous material. In order to fit as much content as 

possible into this course, we will use this procedure instead.  

 To independently measure free space, you will need to create a sample file that 

collects just one relative pressure point at 0.1 P/Po.  The ASAP 2020 will then measure 

the free space of the sample material before measuring the single point.  This quick 

sample file provides us with the free space values (warm and cold) that are necessary 

to enter into the subsequent micropore sample file.     

LAB Session 3 -Y-Zeolite second degas 

Training Activity –Degassing on the sample port (2nd degas) 

Once the single point analysis used to obtain free space values is complete, we must 

re-degas the sample on the sample port.  Follow the guidelines given by your instructor 

to re-degas your Y Zeolite sample. 

Once this exercise is complete, you may create a sample file using micropor.anc and 

yzeolite.rpo to run the micropore analysis.  Please flag your instructor when your 

sample is ready to begin for instructions on entering free space values into the sample 

file. 
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LAB Session 4 - Creating entire Alumina sample file  
 

Training Activity –Creation of complete Alumina sample file and sample 
degas from scratch. 

 

You will now use the previous day(s) activities to measure a sample, create a sample 

file and prep a low surface area Alumina sample.   

 

Low surface area samples below 1m2/g should use krypton gas.  

Nitrogen has a saturation pressure of 760 torr whereas krypton has a saturation 

pressure of only 2.5 torr.  Since pressure is proportional to the number of moles or 

molecules, there are ~ 300 molecules of nitrogen for every 1 molecule of krypton.  Think 

of it like this:  If you have an office party with 1200 people and 2 people sneak off, the 

boss will probably not notice.  If you have a meeting with 4 people, and two people 

sneak off, the boss will not be happy. 

 

A low surface area, BET Multipoint Surface Area file should be created and run.   

All Micromeritics Reference materials come with a booklet that will tell the operator what 

degas conditions to use. This is what the Alumina Booklet looks like: 
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Please use the “Test Amount”, the “Preparation” or degas conditions and the “Test 

Conditions” to create and degas your Alumina sample file. There are a few properties 

that are not mentioned in the reference material booklet because the complete files are 

included with the 2020 Physi software.  Please enter as many properties as you can into 

your analysis, degas and report options files and then compare them with the Alumina 

files that are already saved in the software. 
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Again, compare the sample mass obtained after analysis (Step 7) with the sample mass 

after degas (Step 5). 

 

Sample tube:_____________________ Sample: _______Alumina_______________ 
 
Before Degas: 
 

 

Mass of empty sample tube assembly (sample tube, seal frit and filler rod) 
 

________ g 
 

2. Mass of sample tube assembly plus sample ________ g 
 

3. Mass of sample (Step 2) – (Step 1) ________ g 
 

After Degas: 
 

 

4. Mass of sample tube assembly plus sample ________ g 
 

5. Mass of sample (Step 4) – (Step 1) ________ g 
 

After Analysis: 
 

 

6. Mass of sample tube assembly plus sample ________ g 
 

7. Mass of sample (Step 6) – (Step 1) ________ g 
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DAY 3 - INDEPENDENT ALUMINA ANALYSIS 

LAB Session 1 - Analyzing an Alumina sample 

Training Activity – Analysis of a low surface area Alumina sample with 
krypton 

  

Your Alumina sample should be ready now after an overnight prep.  Please load the 

sample onto the analysis port, top off the analysis dewar, and alert your instructor 

before you initiate the analysis.  The class will observe one analysis for an explanation 

of the analysis steps. 

 

 

    
 


